




Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©January 2007

Trademarks
This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.
Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.
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FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
II
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with a DC Output of 100 - 240V, 50 - 60Hz, 19V, 

3.42A (65 Watts) OR 18.5V, 3.5A (65 Watts) minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
III
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
IV
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
V
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VI
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
VII
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
VIII
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
IX
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
X
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
XI
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.
XII
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Quick Start Guide 1
Chapter 1: Quick Start Guide
Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Function/Hot 
Keys, Quick Buttons, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s Wireless LAN, Bluetooth and PC Camera, modules (some of 

which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the VIA Video driver controls.
• Appendix C The computer’s specification.
• Appendix D Information on the Windows XP OS.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the

 symbol. Also please note the safety and handling instructions as indicated in the Preface.

Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please consult the appropriate manuals.

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in Table 4 - 1, on page 4 - 3. You will be unable to use most advanced controls until the necessary drivers and util-
ities are properly installed. If your system hasn’t been properly configured (your service representative may have already
done that for you); refer to Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
Overview 1 - 3
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-
ported.

Table 1 - 1 - Operating Systems Supported

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Win-
dows XP Information” on page D - 1.

Operating System & Version Supported Note

*Windows XP (Home or Professional) Yes

Windows Vista Home Basic
32-bit Yes

In order to run Windows Vista
without limitations or decreased
performance, your computer requires
a minimum 1GB of system memory
(RAM).

64-bit No

Windows Vista Home Premium
32-bit No

64-bit No

Windows Vista
Business/Enterprise/Ultimate

32-bit No

64-bit No
1 - 4 Overview
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.
6. Adjust the LCD panel to a comfortable viewing angle.
7. The LED indicators show the power and battery status of the computer.

Figure 1 - 1 - AC/DC Adapter In

Shutdown

Note that you should always shut your computer down by choosing
the Shut Down command from the Lock Button Menu in Win-
dows Vista. This will help prevent hard disk or system problems.
System Startup 1 - 5
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System Map: LCD Panel Open

Figure 1 - 2 - Top View with LCD Panel Open
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1. Optional Built-In PC Camera
2. LCD
3. Speakers
4. Power Button
5. Hot Key Buttons
6. Keyboard
7. TouchPad and Buttons
8. Built-In Microphone
9. LED Indicators
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Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator
icon to see if the modules
are powered on or not (see
Table 1 - 2, on page 1 - 7/
Table 1 - 4, on page 1 -
10).
1 - 6 System Map: LCD Panel Open
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LED Indicators
The LED indicators display helpful information about the current status of the computer.

Table 1 - 2 - LED Indicators

Icon Color Description

Green Number Lock Activated

Green Caps Lock Activated

Green Scroll Lock Activated

Green The Computer is On

Blinking Green The Computer is in Sleep Mode

Orange The AC/DC Adapter is Plugged In & the Computer is Powered Off

Orange The AC/DC Adapter is Plugged In & the Battery is Charging

Blinking Orange The Battery has Reached Critically Low Power Status

Green The Battery is Fully Charged

Green Hard Disk Activity

Green The WLAN/Bluetooth Module(s) is/are Powered On
LED Indicators 1 - 7
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Hot Key Buttons
These buttons give instant access to the functions indicated in the table below. The Application  and zoom 
hot key functions depend on whether or not a PC Camera module installed.

Table 1 - 3 - Hot Key Buttons

Hot Key Button Function

PC Camera Installed Activate the BisonCap program/Take Still Picture (See Page 7 - 18)

PC Camera Not Installed Activate Application Quick Button 1 (See Page 2 - 10)

 Activate the Default Internet Program

Activate the Default E-Mail Browser

Audio Record Start/Stop (See Page 2 - 11)

PC Camera Installed  Camera Zoom-In (See Page 7 - 18)

PC Camera Not Installed Activate Application Quick Button 2 (See Page 2 - 10)

PC Camera Installed Camera Zoom-Out (See Page 7 - 18)

PC Camera Not Installed Activate Application Quick Button 3 (See Page 2 - 10)
1 - 8 Hot Key Buttons
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Keyboard
The keyboard has a numerical keypad for easy numeric data input, and features function keys to allow you to
change operational features instantly (see Figure 1 - 3).

Figure 1 - 3 - Keyboard

Fn Key

Function Keys
NumLk & 
ScrLk Keys

Numeric 
Keypad

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system
will detect and enable it automatically. However special functions/hot-keys unique to the system’s regular keyboard may
not work.
Keyboard 1 - 9
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Function Keys
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down (see “Func-
tion Keys/Hot Keys” on page 2 - 9).

Table 1 - 4 - Function Keys

Key Function Key Function

Fn Function Key Fn + F8 Decrease LCD Brightness

Fn + F1 TouchPad Toggle Fn + F9 Increase LCD Brightness

Fn + F3 Mute Toggle Fn + F10 PC Camera Module Power Toggle

Fn + F4 Sleep Toggle Fn + F11 Wireless LAN Module Power Toggle

Fn + F5 Decrease Audio Volume Fn + F12 Bluetooth Module Power Toggle

Fn + F6 Increase Audio Volume Fn + NumLk Number Lock Toggle

Fn + F7 Display Toggle Fn + ScrLk Scroll Lock Toggle

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only
be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk
is on.
1 - 10 Function Keys
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System Map: Front & Rear Views

Figure 1 - 4 - Front & Rear Views

1

2 4
3

1

1. LED Indicators
2. 1 * USB Port
3. DC-In Jack
4. Battery
System Map: Front & Rear Views 1 - 11
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System Map: Left View

1 52 4 63 7

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dia-
logue box, and select the DVD Region (tab) to bring
up the control panel to allow you to adjust the region-
al code (see “DVD Regional Codes” on page 2 -
5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

Figure 1 - 5 - Left View

1. Security Lock Slot
2. Optical Device Drive Bay 

(see page 2 - 3)
3. RJ-11 Modem Jack
4. S/PDIF-Out Jack
5. Microphone-In Jack
6. Headphone-Out Jack
7. Line-In Jack

CD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to an unex-
pected power interruption) you may push the end of a straight-
ened paper clip into the emergency eject hole. Do not use a
sharpened pencil or similar object that may break and become
lodged in the hole. 

Media Warning

Don’t try to remove a floppy disk/CD/DVD while the system is
accessing it. This may cause the system to “crash”.
1 - 12 System Map: Left View
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System Map: Right View 

1
432

ExpressCard Slot

The ExpressCard Slot accepts either ExpressCard/34 or ExpressCard/54 formats.

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) / MS Pro (Memory Stick Pro)
MS Duo (requires PC adapter) / Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

3
5

Figure 1 - 6 - Right View
1. ExpressCard Slot 

(see page 2 - 7)
2. 7-in-1 Card Reader
3. 2 * USB 2.0 Ports
4. RJ-45 LAN Jack
5. External Monitor Port
System Map: Right View 1 - 13
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System Map: Bottom View 

2

3

CPU

The CPU is not a user ser-
viceable part. Opening this
compartment, or accessing
the CPU in any way, may vi-
olate your warranty.

Overheating

To prevent your computer
from overheating make sure
nothing blocks any Vent/Fan
Intake while the computer is
in use.

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery
at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instruc-
tions.

4

1

Figure 1 - 7 - Bottom View
1. Vent/Fan Intake/Outlet
2. Battery
3. Hard Disk Bay Cover
4. CPU/RAM Bay Cover
1 - 14 System Map: Bottom View
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Windows Vista Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Figure 1 - 8 - Start Menu & Control Panel

Click here to toggle Classic View 
Windows Vista Start Menu & Control Panel 1 - 15



Quick Start Guide1

Video Features
You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista. For further information see “VIA Video Driver Controls” on page B - 1.

To access Display Properties in Windows Vista:
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click 

Personalization > Display Settings).
3. Move the slider to the preferred setting in Resolution:  (Figure 1 - 9 on page 1 - 17).
4. Click the arrow, and scroll to the preferred setting In Colors: (Figure 1 - 9 on page 1 - 17).
5. Click Advanced Settings (button)  (Figure 1 - 9 on page 1 - 17) to bring up the Advanced Settings tabs.

OR
6. Right-click the desktop and click Personalize, and then click Display Settings and adjust as above.

1
2

3

1 - 16 Video Features
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Figure 1 - 9 - Display Settings

1 2

3

Video Features 1 - 17



Quick Start Guide1

Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 15) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

Figure 1 - 10 - Power Options

Note: Sleep is the default power saving state in Windows Vista
1 - 18 Power Options
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Chapter 2: Features & Components
Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• 7-in-1 Card Reader
• ExpressCard Slot
• TouchPad and Buttons/Mouse
• Function Keys/Hot Keys
• Application Quick Buttons
• Recording Audio
• Audio Features
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page C - 3) with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For fur-
ther details see “Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 10).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Function Keys/Hot
Keys” on page 2 - 9).

 Figure 2 - 2
Optical Device

1

2

3

1
2 3
Optical (CD/DVD) Device 2 - 3
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 Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.

CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 12.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4 South & Central America, Mexico, 
Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding

 Figure 2 - 3
DVD Regions
Optical (CD/DVD) Device 2 - 5
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 7-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

*Note: The PC adapters are usually supplied with these cards.

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 4
Right View

1. Card Reader

• MMC (MultiMedia Card)
• SD (Secure Digital)
• MS (Memory Stick)
• MS Pro (Memory Stick Pro)

• MS Duo (requires PC adapter*)
• Mini SD (requires PC adapter*)
• RS MMC (requires PC adapter*)

1

2 - 6 7-in-1 Card Reader



Features & Components

2
ExpressCard Slot
The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it.

 Figure 2 - 5
ExpressCard Slot

ExpressCard 
Slot Cover

Make sure you keep the
rubber cover provided in
the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.
ExpressCard Slot 2 - 7
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 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
can configure the functions by double-clicking the TouchPad driver icon  on the
taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer
motion and sensitivity options to your preferences. You will find further information
at www.synaptics.com.

Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 6
Mouse Properties
2 - 8 TouchPad and Buttons/Mouse
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Function Keys/Hot Keys
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn
key is held down. In addition to the basic function key combinations; visual indica-
tors are available when the hot key driver is installed (see “Hot Key Utility” on
page 4 - 7). After installing the driver an icon  will appear in the taskbar.

The hot key buttons on the left side of the computer give quick access to the default
internet browser  and e-mail program . The PC Camera hot key buttons  

 can be used to run the BisonCap application, to take still pictures and to zoom
the camera in/out (see “PC Camera Hot Key Buttons” on page 7 - 18) if a PC Cam-
era module is installed. If you do not have a PC Camera module installed see “Ap-
plication Quick Buttons” on page 2 - 10 for details.

Fn/Hot Key Function & Indicator

Fn + F3 Mute Toggle

Fn + F5/F6 Volume Decrease/Increase

Fn + F8/F9 Brightness Decrease/Increase

Audio Record Start/Stop (see over)

Application Note

The key functions will
only be displayed if the
program is running (i.e.
the icon  is displayed
in the taskbar). If you
have closed the pro-
gram you will need to re-
start the computer in
order to view the key
function icons.

Table 2 - 2
Hot Key & Function 

Key Combo 
Indicators
Function Keys/Hot Keys 2 - 9
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 Application Quick Buttons
Note that the application quick button utility is designed to allow use of the hot key
buttons in absence of the optional PC Camera (only install the application quick
button utility if the PC Camera is not installed). You will need to install the
Quick Button Utility (see “Quick Button Utility” on page 4 - 7) to enable the func-
tions.

The quick buttons give instant access to user-defined applications, with one quick
button press. To configure a program to open when the buttons   (see Table 1
- 3, on page 1 - 8) are pressed, follow the instructions below. The quick buttons will
function as long as the program is running (the icon  will appear in the taskbar).
If the program is not running you will need to restart the computer.

1. Press a button  or right-click the icon  in the taskbar.
2. Select Setup from the menu, scroll to AP1/2/3 and select Custom. 
3. An Open dialog box will appear on the screen.
4. Browse to the directory where the desired application.exe (see sidebar) program 

exists.
5. Double-Click on the program file or choose Open.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut on the
desktop and click Prop-
erties. Click the short-
cut (tab) and see where
the executable file is lo-
cated by clicking the
Open File Location
(button).

 Figure 2 - 7
Quick Button 
Configuration 

Screens
2 - 10 Application Quick Buttons
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Recording Audio
The  audio record hot key button allows you to record audio from either the built-
in microphone, or from a microphone connected to the microphone-in jack. To
record on the computer, setup the audio recording options in Windows as follows
(see Figure 2 - 8 on page 2 - 12).

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (VIA High Definition Audio) and make sure the item is not 

disabled (if you wish to record from the internal microphone make sure that the 
Front Mic is not disabled).

5. Double-click Microphone/Front Mic (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone/Front Mic slider to the level 

required.
7. Click OK and close the control panels.
8. Press the audio record button  to begin the recording process (the record icon 

 will flash in the top left of the screen).
9. Press the  audio record button again to stop the recording process (the record 

icon will disappear from the top left of the screen).
10. The recorded audio file (in .wav format) will appear in the Wav folder in the 

documents folder (Computer > Local Disk (C) > Users > Your Login Name > WAV) 
in the Start menu  (see sidebar).

11. Double-click the file to playback the recorded audio.

WAV Folder

The WAV folder con-
taining recorded audio is
located in the docu-
ments folder named the
same as your Windows
login ID. If you are in
Classic view this folder
will appear in Docu-
ments (Start) and on
the desktop..
Recording Audio 2 - 11
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Right-click

Figure 2 - 8
Audio Setup for 

Recording 
(Windows Vista)
2 - 12 Recording Audio
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the VIA Audio Deck  icon in the taskbar, or on the
desktop  (this will bring up the VIA Audio Deck menu). The volume may also be
adjusted by means of the Fn + F5/F6 key combination.

Click any of the buttons (e.g. ) on the left to expand the audio menu selections. 

Sound Volume 
Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 9
VIA Audio Deck 
Configuration 

Menus
Audio Features 2 - 13
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 Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
2 - 14 Adding a Printer
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Chapter 3: Power Management
Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning on the Computer
• Power Plans
• System Power Options
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows
Vista OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 13).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 9.
3 - 2 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Sleep/Hibernate hot-
key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will shut the computer down). Use Power Options
(Hardware and Sound menu) control panel in Windows Vista to configure this fea-
ture.

Shut Down

Note that you should al-
ways shut your comput-
er down by choosing the
Shut Down command
from the Lock Button
Menu in Windows Vis-
ta. This will help prevent
hard disk or system
problems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button Sleep

Sleep  is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).
Turning on the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

Resuming 
Operation

If the display is off the
system can resume by
pressing any key on the
keyboard.

The system can resume
from Sleep mode by
pressing the Sleep But-
ton key combination (Fn
+ F4), or power button.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans
Power Plans 3 - 5
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System Power Options
You can use the system power options to stop the computer’s operation and restart
where you left off. The system features Sleep and Hibernate power saving states.

Hibernate vs. Shut Down
Hibernate and Shut Down are the same in that the system is off and you need to press
the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.

You can use either method depending on your needs.

Sleep vs. Hibernate
If you want to stay away from your work for just a while, you can put the system into
Sleep instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Sleep mode. Sleep will effectively act as Hibernate if
the computer battery becomes depleted (see “Sleep Mode & Mobile PC Battery” on
page 3 - 7).

Sleep Button

The Sleep Button 
in the Start Menu (not
available in Classic
View) can be used to
send the computer into
Sleep.

Note that Sleep is the
default power saving
state in Windows Vista.
3 - 6 System Power Options
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Sleep
Sleep uses very little system power, and takes a short time to return to full operation.
After an extended period of time in Sleep the computer will save the contents of sys-
tem memory (e.g. any open documents and applications) to the hard disk and shut
the system down. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the hard disk
before it turns the system off. Although it saves the most power it takes the longest
time to return to full operation. You can set your computer to automatically enter Hi-
bernate when the battery power is almost depleted. You will need to enable Hiber-
nate mode from the Advanced Settings in power plans, or you put the system
directly into Hibernate mode from the Lock Button Menu. The system will re-
sume from Hibernate mode by pressing the power button.

Sleep Mode & 
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power. 

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.

Figure 3 - 3
Lock Button Menu 

Hibernate
System Power Options 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to either Sleep or Hibernate. In Sleep, the LED  will blink green.
In Hibernate the LED will be off (battery) or orange (AC/DC adapter). If the only
the display is turned off, the LED will remain green.

Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
Battery Information 3 - 9
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.

Windows Mobility 
Center

The Windows Mobility
Center control panel pro-
vides an easy point of ac-
cess for information on
battery status, power plans
used and wireless device
status etc.

Figure 3 - 6
Windows Mobility 

Center
3 - 10 Conserving Battery Power



Power Management

3

Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 13 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 9 for more information on how to maintain and properly
recharge the battery pack.)
Battery Life 3 - 11
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
3 - 12 Battery Life
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.
3. Click Change plan settings (after saving it) and click Change advanced power 

settings.

Figure 3 - 7
Power Plan Create
Battery Life 3 - 13
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4. Click Change plan settings (after saving it) and click Change advanced power 
settings.

5. Scroll down to Battery and click + to expand the battery options.
6. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 8
Power Options 

Advanced Settings - 
Battery
3 - 14 Battery Life
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
Battery Life 3 - 15
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual CD-
ROM (Win Vista OR WinXP) contains the drivers and
utilities necessary for the proper operation of the com-
puter. There will be two CDs provided; one will con-
tain drivers for Windows Vista, the other will contain
drivers for Windows XP (make sure you install the ap-
propriate drivers for your system).

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Driver Installa-
tion” on page D - 29 for Windows XP information).

Module Driver Installation
The procedures for installing drivers for the Wireless
LAN, Bluetooth, and PC Camera modules are pro-
vided in “Modules & Options” on page 7 - 1.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
CD-ROM and click Install Vista Drivers (button).

If you wish to install the drivers manually see page 4 -
4.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

 
Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.

Driver Page #

Video Page 4 - 5

 Audio Page 4 - 5

Modem Page 4 - 6

LAN Page 4 - 6

CardReader Page 4 - 6

TouchPad Page 4 - 6

Hot Key Utility Page 4 - 7

Quick Button Utility (Only appears if no PC 
Camera module is installed Page 4 - 7

Wireless LAN Page 4 - 8

Bluetooth Page 4 - 8

PC Camera Page 4 - 8
Driver Installation 4 - 3
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Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer application, and
then browse to the executable file in the location listed in the table below and follow the installation procedure
for each driver. Note that X is the drive letter assigned to the CD/DVD-ROM drive.
.

Table 4 - 2 - Driver Location

Driver Driver Location

Video Vista 32bit: X:\Drivers\Video\setup.exe

Audio Vista 32bit: X:\Drivers\Audio\SETUP.EXE

Modem Vista 32bit: X:\Drivers\Modem\ssetup.exe

LAN Vista 32bit: X:\Drivers\LAN\setupvis.exe

CardReader Vista 32bit: X:\Drivers\CardReader\Setup.exe

TouchPad Vista 32bit: X:\Drivers\Touchpad\Setup.exe

Hot Key Utility Vista 32bit: X:\Drivers\Hotkey\4AP.exe

Quick Button Utility Vista 32bit: X:\Drivers\QButton\3AP.exe

802.11 b/g USB WLAN Vista 32bit: X:\Drivers\WLAN\Setup.exe

Bluetooth Module Vista 32bit: X:\Drivers\Bluetooth\setup.exe

PC Camera Module Vista 32bit: X:\Drivers\Camera\setup.exe
4 - 4 Driver Installation
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User Account Control (Win Vista)
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the driver
install procedure), click Cancel to close the window,
and follow the installation procedure as directed.

Driver Installation Procedure

Video
1. Click 1.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Audio
1. Click 2.Install Audio Driver > Yes. 
2. Click Next.
3. Click the button to accept the license and click 

Next.
4. Click Next > Next > Next.
5. Click Finish to restart the computer.
Driver Installation 4 - 5
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Modem
1. Click 3.Install Modem Driver > Yes.
2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 4.Install LAN Driver > Yes.
2. Click OK.
3. The network settings can mow be configured.

CardReader
1. Click 5.Install CardReader Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

TouchPad
1. Click 6.Install Touchpad Driver > Yes.
2. Click Next.
3. Click Finish > Restart Now to restart the com-

puter.
4. You may then configure your TouchPad as out-

lined in “TouchPad and Buttons/Mouse” on 
page 2 - 8.

Modem Country Selection

Go to the Phone and Modem Options control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.
4 - 6 Driver Installation
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Hot Key Utility
1. Click 7.Install Hotkey Utility > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

Quick Button Utility
If you do not have a PC Camera module installed,
then the Quick Button Utility will appear in the Driv-
ers Installer menu (only install the quick button
driver if the PC Camera is not installed). See
Table 1 - 3, on page 1 - 8 and “Application Quick
Buttons” on page 2 - 10 for details.

1. Click 10.Install QButton Utility > Yes.
2. Click Next.
3. Click Finish to restart your computer.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers can-
not co-exist.

If you wish to add a PC Camera module to your comput-
er at a later date, then uninstall the Quick Button Driver
(entitled Multimedia Keyboard Driver)  before install-
ing the PC Camera and driver. Drivers can be unin-
stalled from the Programs and Features (Programs >
Uninstall a program) control panel in Windows.

If you wish to remove a PC Camera module from your
computer at a later date, then uninstall the PC Camera
Driver after removing the camera module. You can then
insert the Device Drivers & Utilities + User’s Manual
CD-ROM and install the Quick Button driver from the
Driver Installation menu.
Driver Installation 4 - 7
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Wireless LAN
See the introduction in “802.11 b/g USB WLAN Mod-
ule” on page 7 - 2, and check the installation proce-
dure.

Bluetooth
See the introduction in “Bluetooth Module” on
page 7 - 7, and check the installation procedure.

PC Camera
See the introduction in “PC Camera Module” on
page 7 - 12, and check the installation procedure.
4 - 8 Driver Installation
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Chapter 5: BIOS Utilities
Overview
This chapter gives a brief introduction to the computer’s built-in software: 

The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

BIOS Settings 
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
Overview 5 - 1
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Startup Screen
Each time you turn on the computer, the system takes a few seconds to conduct tests
on memory, keyboard, mouse and system. As the boot proceeds, you can click the
mouse, or press Enter, and then choose “Launch System Setup” from the Trusted-
Core menu to access the PhoenixBIOS Setup Utility.

Figure 5 - 1
Startup Screen
5 - 2 Startup Screen
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In addition to accessing the Setup menus, you can also select a boot device, view
system information or setup a password  for access to the computer at boot time (see
overleaf). 

Launch System Setup

Tr
us
te
dC
or
e Select Boot Device

Security Enrollment

Patent Informrr ation
System Informrr ation

Continue Booting

Figure 5 - 2
Trusted Core Menu
Startup Screen 5 - 3
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Setting a Boot Password
1. Use the mouse to select Security Enrollment from the menu. A Security Enroll-

ment screen similar to the screen below will then appear:

2. Type in the New Password, and then type it again to Confirm the new password.
3. Click OK to set the password.
4. You will now be prompted to enter the password when the computer boots up.

Note: To clear existing passwords follow the procedure above to bring up the Secu-
rity Enrollment screen and type the existing password. Press Enter (without typing
any password entry) and click Yes to un-enroll.

Figure 5 - 3
Security Enrollment

Enter your new password and confirmrr it.

Secucc ritytt EnEE rnn orr llmll emm nee tnn

Password:

New:

Confirmrr :

Admdd inistrator privileges

Password Warning

If you set a boot pass-
word NEVER forget
your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
5 - 4 Startup Screen
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with four (4) menu headings. When you
select a heading, a new screen appears. Scroll through the features listed on each
screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
Startup Screen 5 - 5



BIOS Utilities

5

Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 4
Main Menu

PhoenixBIOS Setup Utility

Main Advanced Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

<Tab>, <Shift Tab>, or
<Enter> selects field.

System Time: [22:11:05]
System Date: [01/10/2007]

�IDE Channel 0 Master [TSSTcorpCD/DVDW TS-L632D-]
�IDE Channel 2 Master [TOSHIBA MK8032GSX-(S1)]

QuickBoot Mode: [Enabled]

System Memory 633 KB

Extended Memory 894 MB

Main

06
5 - 6 Main Menu
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IDE Channel 0/2 Master (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of either a DVD/CD
Device or HDD on the computer’s IDE Channels. Use the Auto (Type:) setting to
have the items configured automatically for you.

QuickBoot Mode: (Main Menu)
Enable this item to skip certain tests at start up, and thus decrease the time needed to
boot the system.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.
Main Menu 5 - 7
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Advanced Menu

Installed O/S: (Advanced Menu)
This setting tells the computer what kind of operating system you’re using.

Figure 5 - 5
Advanced Menu PhoenixBIOS Setup Utility

Main Advanced Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Select the operating
system installed
on your system which
you will use most
commonly.

Note: An incorrect
setting can cause
some operating
systems to display
unexpected behavior.

Advanced

Installed O/S: [WinXP/Vista]
Legacy USB Support: [Enabled]
Reset Configuration Data: [No]
Enable Multimedia Timer: [No]
Frame Buffer Size: [128MB]
5 - 8 Advanced Menu
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Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.

Enable Multimedia Timer: (Advanced Menu)
Multimedia timer services allow applications to schedule timer events with the
greatest resolution (or accuracy) possible for the hardware platform. These timer ser-
vices are useful for applications that demand high-resolution timing (see your appli-
cation manual for further details). This item is set to Disabled as default.

Frame Buffer Size: (Advanced Menu)
Use this menu item to set the amount of system memory to be allocated for use by
the integrated graphic system. The default memory size allocated is 128MB, and this
may be adjusted to 64MB or 256MB if required.
Advanced Menu 5 - 9
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Win-
dowsXP) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.

Figure 5 - 6
Boot Menu

PhoenixBIOS Setup Utility

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Select �Sub-Menu F10 Save and Exit

Item Specific Help

Keys used to view or
configure devices:
Up and Down arrows
select a device.
<+> and <-> moves
the device up or down.
<x> exclude or include
the device to boot.
<Shift +1> enables or
disables a device.
<1 - 4> Loads default
boot sequence.

Boot priority order:
1: IDE 0: TSSTcorpCD/DVDW TS-L632D-(
2: IDE 1:
3: IDE 2:
4: IDE 4: TOSHIBA MK8032GSX-(S1)
5: USB FDC:
6: USB KEY:
7: USB HDD:
8: PCI BEV: VIA Boot Agent

Excluded from boot order:
: USB CDROM:
: USB ZIP
: USB LS120
: PCI SCSI

Main Advanced Boot Exit
5 - 10 Boot Menu
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 7
Exit MenuPhoenixBIOS Setup Utility

Main Advanced Boot Exit

F1 Help �� Select Item -/+ Change Values F9 Setup Defaults
Esc Exit �� Select Menu Enter Execute Command F10 Save and Exit

Item Specific Help

Exit System Setup and
save your changes to
CMOS.

Exit

Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes
Exit Menu 5 - 11
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Chapter 6: Upgrading The Computer
Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Power Safety 
Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.
1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow .

Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

1
2

3

2

3

1

Figure 6 - 1
Battery Removal
Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (see “Driver Installation” on page 4 - 2), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the hard disk bay cover .
4. Grip the tab and slide the hard disk in the direction of arrow .

HDD System 
Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Figure 6 - 2
Hard Disk Bay & 

Screw

1 3
4

5

321

4

5

6 - 4 Upgrading the Hard Disk Drive
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5. Lift the hard disk up in the direction of arrow .
6. Remove the screws  &  and cover .
7. Reverse the process to install a new hard disk drive.

Figure 6 - 3
HDD Removal

6
7 8 9

6 7

8

9

Upgrading the Hard Disk Drive 6 - 5
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  - .
3. Remove the hard disk bay cover .
4. Remove the screw at point , and use a screwdriver to carefully push out the 

optical device at point .
5. Reverse the process to install the new device.

Figure 6 - 4
Removing the CD/

DVD Device

1 3
4

5
6

4

5

6

321
6 - 6 Upgrading the Optical (CD/DVD) Device
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for
details of supported module types). 

The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the CPU/RAM bay cover and remove screws  - .1 7

3 4

2

5

1

6

7

Figure 6 - 5
CPU/RAM Bay 

Screws
Upgrading the System Memory (RAM) 6 - 7
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3. Remove the bay cover .

4. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 7.

8

8

Figure 6 - 6
CPU/RAM Bay 

Cover Removed

9 10

9 10

9 10

Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 - 7
RAM Module 

Release Latches
6 - 8 Upgrading the System Memory (RAM)
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5. The RAM module will  pop-up, and you can remove it.

6. Pull the latches to release the second module if necessary.
7. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.
8. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

9. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

10. Replace the bay cover and screws.
11. Restart the computer to allow the BIOS to register the new memory configuration 

as it starts up.

11

11

Figure 6 - 8
RAM Module 

Removal
Upgrading the System Memory (RAM) 6 - 9
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Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.

Warranty

The CPU is not a user
serviceable part. Open-
ing this compartment, or
accessing the CPU in
any way, may violate
your warranty.

Unauthorized tampering
with the HDD may also
violate your warranty.
6 - 10 Upgrading the Processor
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• 802.11 b/g USB WLAN Module
• Bluetooth Module
• PC Camera Module

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft. 
Overview 7 - 1
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802.11 b/g USB WLAN Module
If you have included an 802.11b/g USB WLAN module in your purchase option,
you will have the appropriate software provided for your module.

Before installing the 802.11b/g USB WLAN driver, make sure that the Wireless
LAN module is on. Use the Fn + F11 key combination (see “Function Keys” on
page 1 - 10) to toggle power to the Wireless LAN module. Make sure you install
the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

802.11 b/g WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive. 
2. Click Install VISTA Drivers (button), and then click 8.Install WLAN 

Driver > Yes.
3. Click Finish to complete the installation.
4. The operating system is the default setting for Wireless LAN control in 

Windows Vista (see overleaf).

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 2, on
page 1 - 7/Table 1 - 4, on
page 1 - 10).
7 - 2 802.11 b/g USB WLAN Module



Modules & Options

7

Connecting to a Wireless Network
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then click Connect to a network (or right-
click the icon , and then click Connect to a network).

2. In the Show list, click to choose Wireless from the drop-down menu.
3. A list of currently available networks will appear.

Figure 7 - 1
Taskbar Menus

Network and 
Sharing Center

You can also use the
Network and Sharing
Center control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 2
Connect to a 

Network

Click icon Right-click icon
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4. Click a network, and then click Connect.
5. If you do not see a network you want to connect to, click Set up a connection or 

network (a list of options will appear allowing manual searching, and creating a 
new network).

6. Move the cursor over the taskbar icon  to see the connection status (see below).

Figure 7 - 3
Connecting

Figure 7 - 4
Connection Status
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7. To disconnect from the wireless network you can click the taskbar wireless icon 
, and then select Connect or disconnect to access the network menu, and 

click Disconnect (or right-click the icon , and then click Disconnect from).
Security Enabled 

Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure net-
works may allow unautho-
rized access to your
computer, documents, web-
sites and files etc.

Figure 7 - 5
Disconnecting

Click icon

Right-click icon
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:
1. Click Start, and click Control Panel (or point to Settings and click Control 

Panel).
2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 6
Windows Mobility 

Center
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Bluetooth Module
Before installing the Bluetooth driver, make sure that the optional Bluetooth mod-
ule is on. Use the Fn + F12 key combination (see “Function Keys” on page 1 - 10)
to toggle power to the Bluetooth module. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3.

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click Install VISTA Drivers (button), and then click 9.Install Bluetooth 

Driver > Yes.
3. Choose the language you prefer, and click OK > Next.
4. Click the button to accept the license agreement, and then click Next.
5. Click Next > Install.
6. Click Finish, and the BlueSoleil icon  will appear on the desktop.
7. You can configure the settings at any time by going to the IVT Corpora-

tion BlueSoleil - Main Window (Start > Programs/All Programs > IVT 
BlueSoleil > BlueSoleil), or by clicking the desktop icon .

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 2, on
page 1 - 7/ Table 1 - 4, on
page 1 - 10).
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User Guides & Help

View the BlueSoleil
User Guides from the
Help Menu (or press the
F1 key) in the IVT Cor-
poration BlueSoleil -
Main Window control
panel. 

Click the Help menu
and select Contents
and Index. 

Look through  Getting
Started or select the ap-
propriate User Guide
from the Contents
menu.

Figure 7 - 7
BlueSoleil Main 
Window & Help
7 - 8 Bluetooth Module
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Bluetooth Configuration in Windows Vista
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

Turn the Bluetooth Module on
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar (see sidebar).
3. You can then do any of the following to access the Bluetooth Devices control 

panel.

• Double-click the icon  to access the Bluetooth Devices control panel.
• Click Start, and click Control Panel (or point to Settings and click Control Panel), and then 

click Bluetooth Devices (Hardware and Sound).
• Click/Right-click the icon  and choose an option from the menu.

Bluetooth Taskbar 
Icon

If you cannot see the
Bluetooth icon in the
taskbar, access the
Bluetooth Devices
control panel. Click Op-
tions (tab), and make
sure that Show Blue-
tooth icon in the notifi-
cation area check box
(Connections) has a
tick inside it.

Figure 7 - 8
Bluetooth Devices & 

Click Icon Menu
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Install the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click Options (tab), and make sure that Allow Bluetooth devices to connect to 

this computer check box (Connections) has a tick inside it.
3. Click Devices (tab), and then click Add.
4. The Add Bluetooth Device Wizard will appear.
5. Click to select “My device is set up and ready to be found”, and then click Next.

6. The Wizard will then search for any available Bluetooth devices within range.
7. Select the device you which to communicate with, and click Next.
8. Select an appropriate passkey option and click Next.

9. Click Finish.

Figure 7 - 9
Add Bluetooth 
Device Wizard

Figure 7 - 10
Passkey Option
7 - 10 Bluetooth Module
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To Change Settings for the Bluetooth Device
1. Access the Bluetooth Devices control panel.
2. Click on the device you want to change and click Properties to:

• Change the name of the device (click General, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable To Bluetooth Devices
1. Access the Bluetooth Devices control panel.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that Alert me when a new Bluetooth device wants to connect check 

box (Connections) has a tick inside it, if you want to be notified when a Bluetooth 
device wants to connect.

Figure 7 - 11
Bluetooth Devices 

Options
Bluetooth Module 7 - 11
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PC Camera Module
Before installing the PC Camera driver, make sure that the optional PC Camera is
on. Use the Fn + F10 key combination (see “Function Keys” on page 1 - 10) to
toggle power to the PC Camera module. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3. 

Taking Still Pictures

You can use the applica-
tion button  to take still
pictures if you have in-
stalled the hot key driver.
(See “PC Camera Hot
Key Buttons” on page 7
- 18.)

Latest PC Camera Driver Information

Check the CD, and any accompanying insert pages for the latest updated information on
the PC Camera driver, that may override the information provided here.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers cannot co-exist.

If you wish to add a PC Camera module to your computer at a later date, then uninstall the
Quick Button Utility Driver (entitled Multimedia Keyboard Driver)  before installing the PC
Camera and driver. Drivers can be uninstalled from the Add or Remove Programs control
panel in Windows.

If you wish to remove a PC Camera module from your computer at a later date, then unin-
stall the PC Camera Driver after removing the camera module. You can then insert the De-
vice Drivers & Utilities + User’s Manual CD-ROM and install the Quick Button Utility
driver from the Drivers Installer menu.
7 - 12 PC Camera Module
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PC Camera Driver Installation
1. Make sure the module is powered on (click Cancel if you see a “New 

Hardware Found” message), and then insert the Device Drivers & Utilities 
+ User’s Manual CD-ROM into the CD/DVD drive.

2. Click 10.Install Camera Driver > Yes.
3. Choose the language you prefer and click Next.
4. Click Next > Install.
5. Click Finish to restart the computer.
6. Run the BisonCap application program from the BisonCam shortcut on the 

desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).

7. You can use the application button  to run the BisonCap application if 
you have installed the hot key driver (see “Hot Key Utility” on page 4 - 7).

8. A Snapshot folder will be placed on the desktop to record still pictures 
taken with using the application button  (see “PC Camera Hot Key But-
tons” on page 7 - 18).
PC Camera Module 7 - 13
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (VIA High Definition Audio) and make sure the item is not 

disabled (if you wish to record from the internal microphone make sure that the 
Front Mic is not disabled).

5. Double-click Microphone/Front Mic (or select Properties from the right-click 
menu).

6. Click Levels (tab), and adjust the Microphone/Front Mic slider to the level 
required.

7. Click OK and close the control panels.
8. Run the BisonCap application program from the Start > Programs/All Programs 

> BisonCam menu (or press the application button ).
9. Go to the Devices menu heading and select the appropriate recording device (it 

should have a tick alongside it) e.g Front Mic (VIA High Definition).... or 
Microphone (VIA High Definition).... .

10. Go to the Capture menu heading and select Capture Audio (it should have a tick 
alongside it).
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Right-click

Figure 7 - 12
Audio Setup for PC 

Camera
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-
Cam menu, or by pressing the application button  (it is recommended that you 
set the capture file before the capture process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 14) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will be 
asked to choose a file name and size (see the sidebar - Pre-Allocating File 
Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video 

As..., choose a file name and location, and then click Open (you can view the file 
using the Windows Media Player).

Set Capture File
In the BisonCap application you will only be asked to set the capture file name on
the first run of the program. When you run the program the next time the file will
automatically be overwritten with the newly captured file. To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate the
file size for the capture file
in the BisonCap applica-
tion. You can choose to
ignore this by clicking
Cancel.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

You may find it helpful to
defragment the HDD be-
fore capture.
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap application is flickering, you can
try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure 7 - 13
Video Capture Filter
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PC Camera Hot Key Buttons
You can use the PC Camera hot key buttons (the quick button utility must NOT be
installed - see “Quick Button Utility” on page 4 - 7)    to run the BisonCap
program, to take still pictures and to zoom the camera in and out (if you have in-
stalled the hot key and PC Camera drivers - see “Hot Key Utility” on page 4 - 7 &
“PC Camera Driver Installation” on page 7 - 13).

1. Make sure the PC Camera is on (use the Fn + F10 key combination to power on 
the camera).

2. Press the  application button once.
3. The BisonCap application will run.
4. Use the zoom keys to obtain the picture required.
5. Press the  application button for a second time (you will hear a camera motor 

sound to indicate the picture is being taken).
6. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture
using the application hot
key button.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Figure 7 - 14
Snapshot Folder
7 - 18 PC Camera Module
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Chapter 8: Troubleshooting
Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 7) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / 
“Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “Setting a Boot Password” on page 5 - 4).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
Backup and General Maintenance 8 - 3
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
8 - 4 Viruses
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
Upgrading and Adding New Hardware/Software 8 - 5
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices 
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present
and seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4/“Power Schemes” on page D - 20) check its settings. You may also be
using an PC Card/ExpressCard device/USB device/external device that is drawing a lot of power.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 9/
“Battery Information” on page D - 25).

Power Options have been disabled. Go to the Control Panel in Windows and re-enable the
options.

A peripheral device/USB device/PC Card is consuming a lot of power. Turn off/remove the
unused device to save power.
Problems and Possible Solutions 8 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 14). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan
intakes to be blocked.

Nothing appears on
screen.

The system is in a power saving mode. Toggle the sleep/resume key combination, Fn + F4 (see
“Sleep Button” on page 3 - 6/“Sleep Button” on page D - 24).

The screen controls need to be adjusted. Toggle the screen control key combinations Fn + F8/F9.
If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should
also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key combination, Fn + F7. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the
external monitor I have
plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
Appendix B/“Video Features” on page D - 10 for instructions on installing and configuring the
video driver.

Problem Possible Cause - Solution
8 - 8 Problems and Possible Solutions
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You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, or use the key combination Fn + F5 and F6 (see “Function Keys/Hot Keys”
on page 2 - 9) to adjust.

The audio recording
cannot be heard or the
volume is very low.

The recording volume might be set too low. Check the information in “Recording Audio” on
page 2 - 11/“Recording Audio” on page D - 7.

The CD/DVD cannot be
read.

The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will
not open when there is a
disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc using the eject hole
(see “Loading Discs” on page 2 - 3).

Problem Possible Cause - Solution

Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Problems and Possible Solutions 8 - 9
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The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5/
“DVD Regional Codes” on page D - 2.

Unwelcome numbers
appear when typing.

If the LED  is lit, then Num Lock is turned ON. (see “LED Indicators” on page 1 - 7).

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press the sleep (Fn
+ F4) key combination, or press the power button if no LEDs are lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “System Power Options” on page 3 - 6/“System Power Options”
on page D - 22). Make sure you have enabled Hibernate mode from the control panel.

Problem Possible Cause - Solution

Other Keyboards
If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
8 - 10 Problems and Possible Solutions
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The Wireless LAN/
Bluetooth modules
cannot be detected.

The modules are off. Check the LED indicator  and/or function key indicator to see if the
WLAN/Bluetooth module is on or off (see “LED Indicators” on page 1 - 7). If the LED indicator is
off, then press the Fn + F11 (WLAN) or Fn + F12 (Bluetooth) key combination(s) in order to
enable the modules (see “Function Keys” on page 1 - 10).

The PC Camera module
cannot be detected.

The module is off. Press the Fn + F10 key combination in order to enable the module (see
“Function Keys” on page 1 - 10). Run the BisonCap program (see “PC Camera Module” on
page 7 - 12/“PC Camera Module” on page D - 40) to view the camera picture.

The Wireless LAN/
Bluetooth/ PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions for the appropriate module in “Modules &
Options” on page 7 - 1).

Problem Possible Cause - Solution
Problems and Possible Solutions 8 - 11
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Appendix A: Interface (Ports & Jacks)
Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.
A - 2 Interface (Ports & Jacks)
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RJ-11 Modem Jack This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11
telephone connection. 
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

USB 2.0/1.1 Ports These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Item Description
Interface (Ports & Jacks) A - 3
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Appendix B: VIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 16.

VIA Video Driver Installation
Make sure you install all the drivers in the order indicated in Table 4 - 1, on page 4
- 6. Instructions for installing the video driver are repeated below.

Video
1. Click 1.Install Video Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.
VIA Video Driver Installation B - 1
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Advanced Video Controls
This section is about making adjustments for the LCD, and switching display devic-
es. The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 15.

Video Driver Controls
The video interface lets you change the screen resolution and color output to what-
ever is most comfortable/efficient for you. This is a matter of hardware, video mem-
ory and the driver for your operating system.

Video Memory
The system does not feature dedicated video memory, but automatically and dynam-
ically allocates as much (up to 256MB maximum) system memory (RAM) as need-
ed to the video system. You can define the amount of system memory to be allocated
from the BIOS (see “Frame Buffer Size: (Advanced Menu)” on page 5 - 9). The
system returns whatever memory is no longer needed to the operating system.

Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.
B - 2 Advanced Video Controls
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Attaching Other Displays
Besides the built-in LCD, you can also use an external monitor (CRT)/flat panel dis-
play as your display device. Connect it to the external monitor port on the right of
the computer, and follow the instructions below:

Windows Vista
1. Attach your external display to the external monitor port and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click on any of the buttons to configure the displays to your preferences, or click
Display Settings (in the New Display Detected window) to access the control
panel.

Figure B - 1
 New Display 

Detected
Attaching Other Displays B - 3
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External displays may also be configured from S3Display tab in Advanced Display
Settings:
1. Attach the external display to the external monitor port and turn it on.
2. Click Advanced Settings in the Display Settings control panel (see “Video

Features” on page 1 - 16) to display the additional tabs.
3. Select S3Display (tab).
4. Click to put a tick in the tickbox under the CRT icon.
5. Click Apply > OK and allow the monitor time to refresh the display.
6. Click Yes to confirm the settings.
7. Select the CRT icon, and then click Refresh Rate to change the settings for the

attached display.

Figure B - 2
 S3 Display 
B - 4 Attaching Other Displays
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Display Modes
Single Display
Only one of your attached displays is used.

Mirrored
This display mode simply shows an exact copy of the Primary display desktop on
the Secondary display(s). 

Extended Desktop
An Extended desktop allows the desktop to span the displays to act as a large work
area, thus creating a lot more screen area for display. Each display device can be con-
figured independently for specific resolutions and refresh rates. Use the Display Set-
tings control panel to drag the monitors to match the physical arrangement you wish
to use.
Display Modes B - 5
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Using Windows Vista to Enable Extended Mode
1. Attach your external display to the external monitor port, and turn it on.
2. If a New Display Detected window does not appear in Windows Vista, go to the

Windows Mobility Center control panel (Mobile PC > Adjust commonly used
mobility settings) and click Connect display.

3. Click to select Show different parts of my desktop on each display (extended).
4. Click Right or Left under Extend your desktop.
5. Click Apply > OK.

 Display Settings 
Extended Desktop 

Use the control panel to
drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any icons
or windows across to ei-
ther display desktop,
which makes it possible
to have one program
visible in one of the dis-
plays, and a different
program visible in the
other display.

Figure B - 3
New Display 

Detected
B - 6 Display Modes
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Using Display Settings to Enable Extended Mode
1. Attach your external display to the external monitor port, and turn it on.
2. Open the Display Settings control panel (see “Video Features” on page 1 - 16).
3. Click the monitor icon (e.g. ), and make sure you have checked “Extend my

Windows desktop onto this monitor.” and click Apply.

Figure B - 4
Display Properties 

(Extended Desktop)

2

Click the appropriate monitor icon
(e.g. ) to be able to select the op-
tion to extend the desktop on to it.

In this example the Primary Display
 is on the left, the Secondary Dis-

play  is on the right.

2

1
2

Display Modes B - 7
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Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, delayed or updated due to the manufacturer's release schedule. Check
with your service center for details.
Specifications C - 1
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Feature Specification

Processor Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package
T7200/ T7400/ T7600

65nm (65 Nanometer) Process Technology
4MB On-die L2 Cache & 667MHz FSB
2.0/ 2.16/ 2.33 GHz

Intel® Core™2 Duo Processor
(478-pin) Micro-FC-PGA Package
T5500/ T5600

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83 GHz

Intel® Core™ Duo Processor
(478-pin) Micro-FC-PGA Package
T2300/ T2400/ T2500/ T2600/ T2700 

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83/ 2.0/ 2.16/ 2.33 GHz

Intel® Core™ Solo Processor
(478-pin) Micro-FC-PGA Package
T1300/ T1400

65nm (65 Nanometer) Process Technology
2MB On-die L2 Cache & 667MHz FSB
1.66/ 1.83 GHz

Intel® Celeron® M Processor
(478-pin) Micro-FCPGA Package
410/ 420/ 430/ 440/ 450

65nm (65 Nanometer) Process Technology
1MB On-die L2 Cache & 533MHz FSB
1.46/ 1.60/ 1.73/ 1.86/ 2.0 GHz

Core Logic VIA VN896 + VT8237A Chipset

Memory Two 200 Pin SO-DIMM Sockets Supporting DDRII (DDR2) 533/667 MHz
64-bit Wide DDRII (DDR2) Data Per Channel
Memory Expandable up to 2GB (256/ 512/ 1024 MB DDRII Modules)

LCD 15.4" WXGA (1280 * 800) TFT LCD 
C - 2 Specifications
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Video Adapter VIA VN896 Integrated Video System 
(Internal On Chip)

Chrome 9HC™
Integrated 128bit 2D/3D Graphic Engine and Clock up to 250MHz
Supports CRT Resolutions up to 2048 * 1536 at 75Hz
Supports Microsoft DirectX 9.0

Security Security (Kensington® Type) Lock Slot BIOS Password

BIOS One 4Mb Flash ROM Phoenix™ BIOS

Storage One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive (see “Optional” on page C - 5 for 
drive options)
Easy Changeable 2.5" 9.5 mm (h) SATA (Serial) HDD

Audio Integrated AZALIA Compliant Interface (HDA)
3D Stereo Enhanced Sound System
Sound-Blaster PRO™ Compatible
2 * Built-In Speakers
Built-In Microphone

Keyboard & 
Pointing Device

Winkey Keyboard Built-In TouchPad with Scrolling Function

Feature Specification
Specifications C - 3



Specifications

C

Interface Three USB 2.0 Ports
One RJ-11 Modem Jack
One RJ-45 LAN Jack
One DC-in Jack

One External Monitor Port
One Headphone-Out Jack
One Microphone-In Jack
One Line-In Jack
One S/PDIF Out Jack

Card Reader Embedded 7-in-1 Card Reader (MS/ MS Pro/ SD/ Mini SD/ MMC/ RS MMC/ MS Duo) Note: MS Duo/ 
Mini SD/ RS MMC Cards require a PC adapter

ExpressCard Slot One ExpressCard/34(54) Slot

Communication AZALIA 56K Plug & Play Fax/Modem V.90/92 Compliant
10M/100Mb Base-T Ethernet LAN 
802.11 b/g USB Wireless LAN Module (Option) 
USB (2.0) Bluetooth Module - Version 2.0 (Factory Option) 
300K or 1.3M Pixel USB PC Camera Module (Factory Option) 

Power 
Management

Supports ACPI 2.0 and PCI Bus Power 
Management 1.1 Compliant

Battery Low Suspend
Supports Wake on LAN

Power Full Range AC/DC Adapter 19V, 3.42A (65 Watts) OR 18.5V, 3.5A (65 Watts), 100 - 240V, 50 - 60Hz

Battery 6 Cell Smart Lithium-Ion Battery Pack, 4000mAH 

Feature Specification
C - 4 Specifications
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Environmental 
Spec

Temperature
Operating:    5°C ~ 35°C
Non-Operating: -20°C ~ 60°C

Relative Humidity
Operating: 20% ~ 80%
Non-Operating: 10% ~ 90%

Dimensions 
& Weight

360mm (w) * 267mm (d) * 25.4-34mm (h) 2.6 kg With 6 Cell Battery

Optional Optical Drive Module Options:
DVD/CD-RW Combo Drive Module
DVD-Dual Drive Module

802.11 b/g USB Wireless LAN Module 

300K or 1.3M Pixel USB PC Camera Module 
(Factory Option)

USB (2.0) Bluetooth Module - Version 2.0 
(Factory Option) 

Feature Specification
Specifications C - 5
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Appendix D: Windows XP Information
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows XP OS.
D - 1
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DVD Regional Codes

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South Africa, Middle East & Egypt

3 South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong

4 South & Central America, Mexico, Australia, 
New Zealand

5 N Korea, Russia, Eastern Europe, India & Most of Africa

6 China

Table D - 1 - DVD Region Codes Figure D - 1 - DVD Regions

Changing DVD Regional Codes

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives.
Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control
panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is
permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
D - 2 DVD Regional Codes
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Windows XP Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of
the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers. To see
all controls it may be necessary to toggle off Category View.

Figure D - 2 - Start Menu & Control Panel

Click here to toggle Category View

 

Windows XP Start Menu & Control Panel D - 3
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TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one
of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse. 

Once you have installed the TouchPad driver (see “TouchPad” on page D - 34) you can configure the functions
by double-clicking the TouchPad driver icon  on the taskbar. You may then configure the TouchPad tapping,
buttons, scrolling, pointer motion and sensitivity options to your preferences. You will find further information
at www.synaptics.com.

Figure D - 3 - Mouse Properties

Mouse Driver

If you are using an external mouse
your operating system may be able to
auto-configure your mouse during its
installation or only enable its basic
functions. Be sure to check the de-
vice’s user documentation for details.
D - 4 TouchPad and Buttons/Mouse
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Function Keys/Hot Keys
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key
is held down. In addition to the basic function key combinations; visual indicators
are available when the hot key driver is installed (see “Hot Key Utility” on page D -
34). After installing the driver an icon  will appear in the taskbar.

The hot key buttons on the left side of the computer give quick access to the default
internet browser  and e-mail program . The PC Camera hot key buttons  

 can be used to run the BisonCap application, to take still pictures and to zoom the
camera in/out (see “PC Camera Hot Key Buttons” on page D - 46) if a PC Camera
module is installed. If you do not have a PC Camera module installed see “Applica-
tion Quick Buttons” on page D - 6 for details.

Fn/Hot Key Function & Indicator

Fn + F3 Mute Toggle

Fn + F5/F6 Volume Decrease/Increase

Fn + F8/F9 Brightness Decrease/Increase

Audio Record Start/Stop (see over)

Application Note

The key functions will
only be displayed if the
program is running (i.e.
the icon  is displayed
in the taskbar). If you
have closed the pro-
gram you can run it
again from the Start
menu (Start > Pro-
grams > Startup > Hot-
Key Driver) in
Windows.

Table D - 2
Hot Key & Function 

Key Combo 
Indicators
Function Keys/Hot Keys D - 5
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Application Quick Buttons
Note that the application quick button utility is designed to allow use of the hot key
buttons in absence of the optional PC Camera (only install the application quick
button utility if the PC Camera is not installed). You will need to install the Quick
Button Utility (see “Quick Button Utility” on page D - 35) to enable the functions.

The quick buttons give instant access to user-defined applications, with one quick
button press. To configure a program to open when the buttons    are pressed,
follow the instructions below. The quick buttons will function as long as the program
is running (the icon  will appear in the taskbar). If the program is not running you
will need to restart the computer.

1. Press a button    or right-click the icon  in the taskbar.
2. Select Setup from the menu, scroll to AP1/2/3 and select Custom. 
3. An Open dialog box will appear on the screen.
4. Browse to the directory where the desired application.exe (see sidebar) program 

exists.
5. Double-Click on the program file or choose Open.

Application.exe

You will need to locate
the actual application
executable (.exe) file,
not just the shortcut. To
find the application right-
click its shortcut on the
desktop and click Prop-
erties. Click the short-
cut (tab) and see where
the executable file is lo-
cated by clicking the
Find Target (button).

 Figure D - 4
Quick Button  
Configuration 

Screens
D - 6 Application Quick Buttons
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Recording Audio
The  audio record hot key button allows you to record audio from either the built-in microphone, or from a
microphone connected to the microphone-in jack. To record on the computer, setup the audio recording options
in Windows as follows (see Figure D - 5 on page D - 8).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-
click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).

2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select HD Audio rear input (for a microphone plugged in to the microphone-in jack)/HD Audio Front Mic (for 

the built-in microphone) from the Mixer device menu and click OK (make sure there is a tick in the Microphone 
tick box).

5. Click Recording (button) and click OK.
6. Boost the volume in the Microphone section as high as it will go (make sure there is a tick in the Select tick box 

if you have selected HD Audio rear input).
7. Close the open windows.
8. You can also boost the microphone from the Mixer in the VIA Audio Deck  menu (see page D - 9).
9. Press the audio record button  to begin the recording process (the record icon  will flash in the top left of 

the screen).
10. Press the  audio record button again to stop the recording process (the record icon will disappear from the 

top left of the screen).
11. The recorded audio file (in .wav format) will appear in the Shared Documents > Wav folder in My Computer.
12. Double-click the file to playback the recorded audio.
Recording Audio D - 7
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Figure D - 5
Audio Setup for 

Recording 
(Windows XP)
D - 8 Recording Audio
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Audio Features
You can configure the audio options on your computer from the Sounds and Audio
Devices  Windows control panel, or from the VIA Audio Deck  icon in the
taskbar, or on the desktop (this will bring up the VIA Audio Deck menu). The vol-
ume may also be adjusted by means of the Fn + F5/F6 key combination. 

Sound Volume 
Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows (and the volume
control function keys on
the computer). Click the
Volume icon on the
taskbar to check the set-
ting.

 Figure D - 6
VIA Audio Deck 
Configuration 

Menus

Microphone 
    Boost
Audio Features D - 9
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Video Features
You can switch display devices, and configure display options, from the Display Properties control panel in
Windows as long as the video driver is installed. For further information see either “VIA Video Driver Con-
trols” on page D - 12 (from pages D - 12 to D - 16).

1. Click Start, point to Settings and click Control Panel (or click Control Panel).
2. Double-click Display (icon); Display (icon) is in the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.

4. Move the slider to the preferred setting in Screen resolution .
5. Click the arrow, and scroll to the preferred setting in Color quality .
6. Open the Display Properties control panel, and click Advanced (button) 

 to bring up the Advanced properties tabs. 
7. The Advanced properties tabs include specific VIA controls, which allow 

you to make any video adjustments you require.

Figure D - 7 - Display Properties

1
2

3

3

1
2

D - 10 Video Features
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Advanced Video Controls
This section is about making adjustments for the LCD, and switching display devic-
es.

Video Driver Controls
The video interface lets you change the screen resolution and color output to what-
ever is most comfortable/efficient for you. This is a matter of hardware, video mem-
ory and the driver for your operating system.

Video Memory
The system does not feature dedicated video memory, but automatically and dynam-
ically allocates as much (up to 256MB maximum) system memory (RAM) as needed
to the video system. You can define the amount of system memory to be allocated
from the BIOS (see “Frame Buffer Size: (Advanced Menu)” on page 5 - 9). The
system returns whatever memory is no longer needed to the operating system.

Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.
Advanced Video Controls D - 11
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VIA Video Driver Controls

VIA S3Tray Plus Utility
The S3Tray Plus utility will appear in the taskbar when the video driver is installed.
Click/Right-click the icon  to bring up the menu below. From this menu you will
also be able to make display adjustments, access the Display Properties control panel,
check video memory information etc.

Figure D - 8
S3Tray Plus Taskbar 

Utility

Click Icon
Right-Click

Icon
D - 12 VIA Video Driver Controls
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VIA S3 Display Control Panels
Right-click the S3Tray Plus utility  in the taskbar to bring up the menu for the
individual control panels, or access the menus from the Advanced tab in the Display
Properties control panel.

Help Menus

Right-click on almost
any item in the tabs to
bring up the “What’s
This?” button.

Click the “What’s
This?” button to bring
up a help menu (if the
item has a help menu
associated with it).

Figure D - 9
S3 Control Panels

Help Menu
VIA Video Driver Controls D - 13
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Display Devices (VIA)
Besides the built-in LCD, you can also use an external monitor (CRT)/flat panel dis-
play as your display device. Connect it to the external monitor port on the right of the
computer. See the instructions below:

1. Attach the external display to the external monitor port and turn it on.
2. Click Advanced in the Display Properties control panel (see “Video Features” on

page D - 10) to display the additional tabs.
3. Select S 3Display (tab).
4. Click to put a tick in the tickbox under the CRT icon.
5. Click Apply > OK and allow the monitor time to refresh the display.
6. Click Yes to confirm the settings.

S3Tray Plus Utility

You can also use the
S3Tray Plus utility in
the taskbar to config-
ure an external dis-
play.

Attach the external dis-
play (CRT) to the ex-
ternal monitor port.

Right-click the 
icon in the taskbar and
select S3Display.

Select the CRT (it
should have a tick
alongside it) and click
Yes to confirm the set-
tings.

Figure D - 10
S 3Display
D - 14 Display Devices (VIA)
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Display Modes (VIA)
Single Display
Only one of your attached displays is used.

Multiple Monitors
This display mode simply shows an exact copy of the Primary display desktop on
the Secondary display(s). 

Extended Desktop
An Extended desktop allows the desktop to span the displays to act as a large work
area, thus creating a lot more screen area for display. Each display device can be con-
figured independently for specific resolutions and refresh rates. Use the Display
Properties control panel to drag the monitors to match the physical arrangement you
wish to use.

Playing DVD Videos

If you want to play a
DVD video in a multiple
monitor mode, then
choose EITHER the
notebook LCD OR ex-
ternal display as the dis-
play device. It is not
possible to play a DVD
video simultaneously on
both displays.
Display Modes (VIA) D - 15
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To Enable Extended Desktop (Display Properties)
1. Attach the external display to the external monitor port and turn it on.
2. Go to the Display Properties control panel (see “Video Features” on page D - 10)

and click Settings (tab).
3. Click the monitor icon (e.g. ), and click to put a tick in the “Extend my Windows

desktop onto this monitor.” box, and then click Apply.
4. As long as the appropriate monitor icon is selected you can adjust the screen

resolution, color quality etc.
5. Click Apply > Yes to confirm any setting changes 

 Display Settings 
Extended Desktop 

Use the control panel
to drag the monitors to
match the physical ar-
rangement you wish to
use. 

You can drag any
icons or windows
across to either display
desktop, which makes
it possible to have one
program visible in one
of the displays, and a
different program visi-
ble in the other display.

Figure D - 11
Display Properties 

(Extended 
Desktop)

2

Click the appropriate monitor
icon (e.g. ) to be able to select
the option to extend the desktop
on to it.

In this example the Primary mon-
itor  is on the left, the secondary
display  is on the right.

2

1
2
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Power Management Features
To conserve power, especially when using the battery, your computer uses the ACPI
power management system. Power management conserves power by controlling in-
dividual components of the computer (the monitor and hard disk drive) or the whole
system.

The Power Options control panel icon in Windows (see page D - 3) allows you to
configure power management features for your computer. You may conserve power
through individual components such as the monitor or hard disk, or you may use ei-
ther Stand by or Hibernate mode to conserve power throughout the system.

Advanced Configuration and Power Interface
The ACPI interface provides the computer with enhanced power saving techniques
and gives the operating system (OS) direct control over the power and thermal states
of devices and processors. For example, it enables the OS to set devices into low-
power states based on user settings and information from applications. ACPI is fully
supported in Windows XP.

OS Note

Power management
functions will vary
slightly depending on
your operating system.
For more information it
is best to refer to the
user’s manual of your
operating system. 

(Note: All pictures
used on the following
pages are from the
Windows XP OS.)
Power Management Features D - 17
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage
the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable.
Battery life varies depending on the applications and the configuration you're using. To increase battery life,
let the battery discharge completely before recharging (see “How do I completely discharge the battery?”
on page D - 28).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery
Information” on page D - 25.
D - 18 The Power Sources
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Turning on the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.

Shutdown

Note that you should al-
ways shut your comput-
er down by choosing the
Turn Off Computer
command from the Start
menu in Windows. This
will help prevent hard
disk or system prob-
lems.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow-
er button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Stand by or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s
“Power Options” control panel to set the power button to send the system into Stand by or
Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on
page D - 24 for details).
Turning on the Computer D - 19



Windows XP Information

D

Power Schemes
You can set your computer to conserve power through individual components by
means of Power Schemes. You can also adjust the settings for each scheme to set
the monitor to turn off after a specified time, and the computer's hard disk motor to
turn off if the hard disk drive has not been accessed for a specified period of time (if
the system reads or writes data, the hard disk motor will be turned back on). The
schemes may also be set to set a specified time for the system to enter Stand by or
Hibernate modes (see “System Power Options” on page D - 22).

Resuming 
Operation

Press a key on the key-
board, or move the
mouse/TouchPad to re-
sume from Monitor or
Hard Disk Stand by.

Figure D - 12
Power Schemes
D - 20 Power Schemes
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Each Windows Power Scheme will also adjust the processor performance of your machine in order to save pow-
er. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery
power).

Choose the Home/Office Desk scheme for maximum performance when the computer is powered from an AC
power source. Choose the Max Battery scheme (bear in mind that this scheme may slow down the overall per-
formance of the computer in order to save power) for maximum power saving when the computer is battery (DC
power) powered. Windows will use Portable/Laptop as the default scheme.
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System Power Options
You can use the system power options to stop the computer’s operation and restart
where you left off. This system features Stand by and Hibernate sleep mode levels
(Hibernate mode will need to be enabled by clicking the option in the Hibernate tab
in the Power Options control panel - see “Hibernate” on page D - 23).

Hibernate Mode vs. Shutdown
Hibernate mode and Shutdown are the same in that the system is off and you need to
press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off
(what was on your desktop) without reopening the application(s) and file(s) you last
used.

You can use either method depending on your needs. 

Stand by Mode vs. Hibernate Mode
If you want to stay away from your work for just a while, you can put the system on
Stand by instead of in hibernation. It takes a longer time to wake up the system from
Hibernate mode than from Stand by mode.

Stand by/Hibernate 
or Shutdown Error

The computer may stop
responding when you
put it into (or resume
from) Stand By or Hiber-
nate, or when you shut
down.

This error is caused by
power management
within Windows XP,
when applied to a PC
Camera attached to the
internal USB hub.

Microsoft has posted a
Hotfix for this error on its
website (search for Hot-
fix KB909667). 

Download and install the
Hotfix to correct this er-
ror.
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Stand by
Stand by saves the least amount of power, but takes the shortest time to return to full
operation. During Stand by the hard disk is turned off, and the CPU is made to idle
at its slowest speed. All open applications are retained in memory. When you are not
using your computer for a certain length of time, which you specify in the operating
system, it will enter Stand by mode to save power. 

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD be-
fore it turns the system off. Although it saves the most power it takes the longest time
to return to full operation. You can set your computer to automatically enter Hiber-
nate mode when the battery power is almost depleted. You will need to enable Hi-
bernate mode from the Hibernate tab in the Power Options control panel. The
system will resume from Hibernate mode by pressing the power button.

System Resume

The system can resume
from Stand by mode by:

• Pressing the power
button

• Pressing the Sleep/
Resume key combi-
nation

• An incoming call
received on the
modem (if enabled)

• Network card (Wake
On LAN) activity (if
enabled)

Figure D - 13
Enable Hibernation
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Configuring the Power Button
The power button may be set to send the computer in to either Stand by or Hiber-
nate mode. In Stand by mode, the LED  will blink green. In Hibernate mode
the LED will be off (battery) or orange (AC/DC adapter). If you are in a power saving
mode set to save power through individual components (e.g. hard disk, monitor), the
LED will remain green.

Sleep Button

You may also configure
the Sleep/Resume key
combination (Fn + F4)
from the menu illustrat-
ed. In Windows this is
referred to as the Sleep
button.

Figure D - 14
Power Options

(Advanced - Power 
Buttons)

(Sleep) Button
Power Button Sleep/ResumeLid
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Battery Information
Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page D - 28 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs
you are running, and peripheral devices attached. Power Options (you may set low
battery Alarms and actions, and check the Power Meter from the Power Options
control panel), and settings in the OS will help prolong the battery life if configured
appropriately.

Low Battery 
Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure D - 15
Power Options 
(Alarm & Power 

Meter)
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Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you need to remove
the battery for any reason, see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page D - 25 for more information on how to maintain and properly
recharge the battery pack.)

Conserving Battery 
Power

To conserve battery power:

Lower the brightness level
of the LCD display. The
system will decrease LCD
brightness slightly to save
power when it is not pow-
ered by the AC/DC adapt-
er.

Close modem or communi-
cation applications when
they are not being used.

Remove any unused
ExpressCards from the
computer (ExpressCards
quickly use up battery
power even if the system
enters sleep mode).

Disconnect any unneces-
sary external devices.
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer by yourself even when you see a message that indicates the bat-
tery is critically low, just let the computer use up all of the battery power and shut
down on its own. Disable the Power Options functions in the Control Panel, espe-
cially any Alarms (unclick the tickboxes - see page D - 25) and Schemes (change
all the settings to Never - see page D - 20). As the battery nears the end of its life save
and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
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Driver Installation
The Device Drivers & Utilities + User’s Manual CD-
ROM contains the drivers and utilities necessary for
the proper operation of the computer. Table D - 3 lists
what you need to install, and it is very important that
the drivers are installed in the order indicated. 

Only install drivers for modules (WLAN, Bluetooth,
and PC Camera) included in your purchase option.

Installation Methods (Win XP)
You may choose to install the drivers from the autorun
program, or install them manually.

Table D - 3 - Driver Installation

WinXP SP2 Driver Page #

Install the appropriate Service Pack for WinXP Page D - 31

 Chipset Page D - 32

Video Page D - 32

Audio Page D - 32

Modem Page D - 33

LAN Page D - 33

CardReader Page D - 33

TouchPad Page D - 34

Hotkey Utility Page D - 34

Wireless LAN Page D - 36

Bluetooth Page D - 38

PC Camera Page D - 41

Install Quick Button Utility (Only appears if no PC 
Camera module is installed Page D - 35
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What to Install
This section covers driver and utility installation instruc-
tions for Windows XP Home & Professional. Insert the
Device Drivers & Utilities + User’s Manual CD-ROM,
click Install WinXP Drivers (button) and then click the
appropriate driver name from the Drivers Installer menu
and then follow the instructions to install the driver. Al-
ternatively Click Start and navigate (Browse..) to fol-
low the manual setup instructions.

Figure D - 16 - Drivers Installer Screen 1

1. Check the driver installation order from Table D - 3 
(all the drivers must be installed in this order) 
which is the same as that listed in the Drivers 
Installer menu below.

2. Click to select the driver you wish to install, after 
installing each driver it will become grayed out (if 
you need to reinstall any driver, click the Unlock 
button).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

Figure D - 17 - Drivers Installer Screen 2

Note that the Quick But-
ton Utility only appears
if you DO NOT have a
PC Camera Module in-
stalled.
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Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may
be necessary to uninstall the original driver.To do this go
to the Control Panel in the Windows OS and double-
click the Add/Remove Programs item. If you see the
individual driver listed (if not see below), uninstall it,
following the on screen prompts (it may be necessary to
restart the computer). Go to the appropriate section of the
manual to complete the update/reinstall procedure for the
driver in question.

If the driver is not listed in the Add/Remove Programs
item:
1. Click Start (menu), point to Settings and click Control 

Panel (or click Start > Control Panel). 
2. Double-click System (icon); System (icon) is in 

Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the 

driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver 

tab) and follow the on screen prompts.

Windows XP Service Pack 2

Make sure you install Windows XP Service Pack 2 (or a
Windows XP version which includes Service Pack 2) be-
fore installing any drivers. Service Pack 2 includes sup-
port for USB 2.0.

If you have upgraded the system by installing Service
Pack 2 (i.e. your Windows XP version does not include
Service Pack 2) then follow these instructions:

1.Click Start (menu), point to Settings and click Con-
trol Panel (or click Control Panel).

2.Double-click System (icon); System (icon) is in Per-
formance and Maintenance (category).

3.Click the Hardware (tab) > Device Manager (button). 
4.Click “+” next to Other Devices (if its sub-items are

not shown).
5.Right-click Universal Serial Bus (USB) Controller

and select Uninstall > OK (if you don’t see the item
then there is no need to take any further action).

6.Restart the computer and it will find the USB 2.0 con-
troller.
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New Hardware Found
If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the driver
install procedure), click Cancel to close the window,
and follow the installation procedure as directed.

Driver Installation Procedure
Note that X is the drive letter assigned to the CD/
DVD-ROM drive.

Chipset
1. Click 1.Install Chipset Driver > Yes.

OR
Click Start (menu) > Run... and navigate 
(Browse...) to 
X:\Drivers\Chipset\SETUP.EXE and click OK.

2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Next > Next > Next.
5. Click Finish to restart the computer.

Video
1. Click 2.Install Video Driver > Yes. 

OR
Navigate (Browse...) to 
X:\Drivers\Video\setup.exe and click OK.

2. Click Finish.

Audio
1. Click 3.Install Audio Driver > Yes. 

OR
Navigate (Browse...) to 
X:\Drivers\Audio\SETUP.EXE and click 
OK.

2. Click Next > Next > Next.
3. Click Finish to restart the computer.
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Modem
1. Click 4.Install Modem Driver > Yes. 

OR
Click Start (menu) > Run... and navigate 
(Browse...) to 
X:\Drivers\Modem\ssetup.exe and click OK.

2. Click OK.
3. The modem is ready for dial-up configuration.

LAN
1. Click 5.Install LAN Driver > Yes. 

OR 
Click Start (menu) > Run... and navigate 
(Browse...) to 
X:\Drivers\LAN\WinSetup.exe and click 
OK.

2. Click OK.
3. The network settings can now be configured.

CardReader
1. Click 6.Install CardReader Driver > Yes. 

OR 
Click Start (menu) > Run... and navigate 
(Browse...) to 
X:\Drivers\Cardreader\Setup.exe and click 
OK.

2. Click Next > Next.
3. Click Finish to restart the computer.

Modem Country Selection

Be sure to check if the modem country selection is ap-
propriate for you (Control Panel > Phone and Modem
Options).
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TouchPad
1. Click 7.Install TouchPad Driver > Yes. 

OR 
Click Start (menu) > Run... and navigate 
(Browse...) to 
X:\Drivers\Touchpad\Setup.exe and click 
OK.

1. Click Next > Next > Next (click Continue 
Anyway if asked if you want to continue at any 
time).

2. Click Finish to restart the computer..

Hot Key Utility
1. Click 8.Install Hotkey Utility > Yes. 

OR 
Click Start (menu) > Run... and navigate 
(Browse...) to 
X:\Drivers\Hotkey\Setup.EXE and click OK.

2. Click Next > Install.
3. Click Finish > Finish to restart the computer.
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Quick Button Utility
If you do not have a PC Camera module installed,
then the Quick Button Utility will appear in the Driv-
ers Installer menu (only install the quick button
driver if the PC Camera is not installed). See
Table 1 - 2, on page 1 - 7 and “Application Quick
Buttons” on page D - 6 for details.

1. Click 11.Install Quick button Utility > Yes.
OR 
Click Start (menu) > Run... and navigate 
(Browse..) to 
X:\Drivers\QButton\3AP.exe and click OK.

2. Click Next.
3. Click Finish to restart your computer.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers can-
not co-exist.

If you wish to add a PC Camera module to your comput-
er at a later date, then uninstall the Quick Button Driver
(entitled Multimedia Keyboard Driver)  before install-
ing the PC Camera and driver. Drivers can be unin-
stalled from the Add or Remove Programs control panel
in Windows.

If you wish to remove a PC Camera module from your
computer at a later date, then uninstall the PC Camera
Driver after removing the camera module. You can then
insert the Device Drivers & Utilities + User’s Manual
CD-ROM and install the Quick Button driver from the
Driver Installation menu.
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802.11 b/g USB WLAN Module
If you have included an 802.11b/g USB WLAN module in your purchase option, you
will have the appropriate software provided for your module.

Before installing the 802.11b/g USB WLAN driver, make sure that the Wireless
LAN module is on. Use the Fn + F11 key combination (see “Function Keys” on
page 1 - 10) to toggle power to the Wireless LAN module. Make sure you install
the drivers in the order indicated in Table D - 3, on page D - 29.

802.11 b/g WLAN Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive. 
2. Click 9.Install WLAN Driver > Yes.

OR 
Click Start (menu) > Run... and navigate (Browse...) to
X:\Drivers\WLAN\Setup.exe and click OK.

3. Click Next.
4. Click Finish to complete the installation.
5. The operating system is the default setting for Wireless LAN control in Win-

dows XP (see overleaf).
6. Access any available wireless networks from Network Connections > 

Wireless Network Connection menu in Windows (or click the icon  in 
the taskbar), and click View Wireless Connections.

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination to toggle power to
the WLAN module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 3, on
page 1 - 8/ Table 1 - 4, on
page 1 - 10).
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Network 
Connection

Use the Windows Net-
work Connections con-
trol panel to access
available wireless net-
works (Start > Settings >
Network Connections
or Start > Connect To >
Show all Connections).

Figure D - 18 
Wireless Network 

Control Panels
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Bluetooth Module
Before installing the Bluetooth driver, make sure that the optional Bluetooth module
is on. Use the Fn + F12 key combination (see “Function Keys” on page 1 - 10) to
toggle power to the Bluetooth module. Make sure you install the drivers in the or-
der indicated in Table 4 - 1, on page 4 - 3.

Bluetooth Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual CD-ROM into the CD/DVD drive.
2. Click 10.Install Bluetooth Driver > Yes.

OR 
Click Start (menu) > Run... and navigate (Browse...) to
X:\Drivers\Bluetooth\Setup.exe and click OK.

3. Click Install Software Drivers v2.3.0.1.
4. Choose the language you prefer, and click OK.
5. Click Next.
6. Click the button to accept the license agreement, and then click Next.
7. Click Next > Next > Install.
8. Click Finish.
9. You can configure the settings at any time by going to the IVT Corporation 

BlueSoleil - Main Window control panel (Start > Programs/All Programs 
> IVT BlueSoleil), or by clicking the taskbar/desktop icon .

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the indicator to see if
the module is powered on
or not (see Table 1 - 2, on
page 1 - 7/ Table 1 - 4, on
page 1 - 10).
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User Guide

View the BlueSoleil User
Guides (Contents and In-
dex) from the Help menu
(or press the F1 key) in
the IVT Corporation
BlueSoleil - Main Win-
dow control panel. Click
BlueSoleil User Guides
in the Contents tab, and
click to select the appro-
priate User Guide from
the panel on the right.

Figure D - 19
Bluetooth Control 

Panel & User Guides
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PC Camera Module
Before installing the PC Camera driver, make sure that the optional PC Camera is
on. Use the Fn + F10 key combination (see “Function Keys” on page 1 - 10) to
toggle power to the PC Camera module. Make sure you install the drivers in the
order indicated in Table 4 - 1, on page 4 - 3. 

Taking Still Pictures

Double-click the My
Computer icon on the
desktop, or go the Start
menu and point to My
Computer, then click it.

.Double-click the Bison-
Cam, NB Pro icon.

 

Click Take a new picture
in the Camera Tasks
box.

You can use the applica-
tion button  to take still
pictures if you have in-
stalled the hot key driver.
(See “PC Camera Hot
Key Buttons” on page D
- 46.)

Latest PC Camera Driver Information

Check the CD, and any accompanying insert pages for the latest updated information on
the PC Camera driver, that may override the information provided here.

Adding/Removing a PC Camera

Note that the Quick Button and PC Camera drivers cannot co-exist.

If you wish to add a PC Camera module to your computer at a later date, then uninstall the
Quick Button Utility Driver (entitled Multimedia Keyboard Driver)  before installing the PC
Camera and driver. Drivers can be uninstalled from the Add or Remove Programs control
panel in Windows.

If you wish to remove a PC Camera module from your computer at a later date, then unin-
stall the PC Camera Driver after removing the camera module. You can then insert the De-
vice Drivers & Utilities + User’s Manual CD-ROM and install the Quick Button Utility
driver from the Drivers Installer menu.
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PC Camera Driver Installation
1. Make sure the module is powered on (click Cancel if you see a “New Hard-

ware Found” message), and then insert the Device Drivers & Utilities + 
User’s Manual CD-ROM into the CD/DVD drive.

2. Click 11.Install Camera Driver > Yes.
OR 
Click Start (menu) > Run... and navigate (Browse...) to
X:\Drivers\Camera\Driver\Setup.exe and click OK.

3. Choose the language you prefer, and click OK.
4. Click Next > Finish to restart the computer.
5. Run the BisonCap application program from the BisonCam shortcut on the 

desktop or from the BisonCam item in the Start > Programs/All Programs 
menu (if the hardware is turned off use the Fn + F10 key combination to 
turn it on again).

6. You can use the application button  to run the BisonCap application if 
you have installed the hot key driver (see “Hot Key Utility” on page 4 - 7).

7. A Snapshot folder will be placed on the desktop to record still pictures 
taken with using the application button  (see “PC Camera Hot Key But-
tons” on page D - 46).

Stand by/Hibernate 
or Shutdown Error

The computer may stop
responding when you
put it into (or resume
from) Stand By or Hiber-
nate, or when you shut
down.

This error is caused by
power management
within Windows XP,
when applied to a PC
Camera attached to the
internal USB hub.

Microsoft has posted a
Hotfix for this error on its
website (search for Hot-
fix KB909667). 

Download and install the
Hotfix to correct this er-
ror.
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in
Windows (see Figure D - 20 on page D - 43).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-
click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).

2. Click Advanced in the Volume > Device volume tab.
3. Click Options and scroll down and click Properties.
4. Select HD Audio rear input (for a microphone plugged in to the microphone-in jack)/HD Audio Front Mic (for 

the built-in microphone) from the Mixer device menu and click OK (make sure there is a tick in the Microphone 
tick box).

5. Click Recording (button) and click OK.
6. Boost the volume in the Microphone section as high as it will go (make sure there is a tick in the Select tick box 

if you have selected HD Audio rear input).
7. Close the open windows.
8. You can also boost the microphone from the Mixer in the VIA Audio Deck  menu (see page D - 9).
9. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu (or press 

the application button ).
10. Go to the Devices menu heading and select HD Audio rear input OR HD Audio front mic (it should have a 

tick alongside it).
11. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
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Figure D - 20
Audio Setup 

(Windows XP)
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BisonCap
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1. Run the BisonCap application from the Start > Programs/All Programs > Bison-
Cam menu, or by pressing the application button  (it is recommended that you 
set the capture file before the capture process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page D - 42) and select Start Capture.

3. On the first run of the program (if you have not set the captured file) you will be 
asked to choose a file name and size (see the sidebar - Pre-Allocating File 
Space) for the captured file. Click Start Capture again.

4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., 

choose a file name and location, and then click Open (you can view the file using 
the Windows Media Player).

Set Capture File
In the BisonCap application you will only be asked to set the capture file name on
the first run of the program. When you run the program the next time the file will au-
tomatically be overwritten with the newly captured file. To avoid overwriting files
you can go to the Set Capture File.. option in the File menu, and set the file name
and location before capture. Set the name and location then click Open (you can
choose Cancel to ignore the file size if prompted).

Pre-Allocating File 
Space

You may pre-allocate the
file size for the capture file
in the BisonCap applica-
tion. You can choose to
ignore this by clicking
Cancel.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

You may find it helpful to
defragment the HDD be-
fore capture.
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Eliminating Screen Flicker
If you find that the video screen in the BisonCap application is flickering, you can
try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

Figure D - 21
Video Capture Filter
PC Camera Module D - 45



Windows XP Information

D

PC Camera Hot Key Buttons
You can use the PC Camera hot key buttons (the quick button utility must not be in-
stalled - see “Quick Button Utility” on page D - 35)    to run the BisonCap
program, to take still pictures and to zoom the camera in and out (if you have installed
the hot key and PC Camera drivers - see “Hot Key Utility” on page D - 34 & “PC
Camera Driver Installation” on page D - 41).

1. Make sure the PC Camera is on (use the Fn + F10 key combination to power on the 
camera).

2. Press the  application button once.
3. The BisonCap application will run.
4. Use the zoom keys to obtain the picture required.
5. Press the  application button for a second time (you will hear a camera motor 

sound to indicate the picture is being taken).
6. The picture (in JPEG format) will be placed in the Snapshot folder on the desktop.

Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture
using the application hot
key button.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.

Figure D - 22
Snapshot Folder
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